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Microsoft Outlook 2010 
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This handout is simply an outline to be used as a guide in class.  Microsoft Outlook offers many ways to 
accomplish different tasks.  The steps below identify at least one way to accomplish a task in Microsoft 
Outlook. 
  
W H A T IS M I C R OSO F T O U T L O O K?  
  
Microsoft  Outlook  2010  is  communication  software  with  simple-­to-­use  tools  that  enable  you  to  send,  receive,  
and  manage  e-­mail.    You  can  easily  manage  your  tasks,  contacts,  and  calendar.    When  using  Microsoft  Outlook  
together  with  the  Exchange  Server,  information  is  sent  and  received  immediately.    Microsoft  Outlook  2010  
includes  new  features  and  capabilities  to  help  you  stay  connected  with  people  and  better  manage  your  time  and  
information.  
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When  seeking  help  from  the  help  desk  or  purchasing  a  book,  you  need  to  know  the  correct  version  of  the  
software  you  are  using.    To  find  the  version  installed  on  your  computer,  follow  the  steps  below:  
  
1. Click  the  File  tab.    This  is  the  
Backstage  view.  

2. Click  the  Help  tab  on  the  left  
side.    The  version  is  displayed  
on  the  right  side  of  the  
Backstage  view.    Microsoft  
Outlook  is  part  of  the  
Microsoft  Office  Professional  
Plus  2010  suite.  

3. When  finished,  click  the  File  
tab  again  to  close  the  
Backstage  view.  
?@AB-"#C%0D-#$/E$:      
Close  the  Backstage  view  by  
pressing  the  Esc  button  on  
your  keyboard.    

  



Page  2  of  20  

G E T T IN G H E LP W I T H IN O U T L O O K 2010 
 

�¾ Pressing F1 on the keyboard. 
�¾ Clicking the Help button on the right side of the Ribbon.   
�¾ Click the File tab, click Help then click Microsoft Office Help 

 
 

 
 
 
 

C O N T A C T IN G T H E MSU H E LPD ESK 
 

�¾ Call 389-6654 
�¾ Online at http://helpdesk.mnsu.edu 
�¾ E-mail helpdesk@mnsu.edu 
�¾ Visit us on the 3rd floor of the Memorial Library 
�¾ You can also go to http://www.microsoft.com/outlook.  
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Quota at Minnesota State University, Mankato for faculty and staff is 1 GB and for students is 300 MB.  In the 
Backstage view, on the Info tab, your account information includes a Quota Thermometer, a visual 
representation of how much space is left in your mailbox. 

 
 
%
% %

http://helpdesk.mnsu.edu/
mailto:helpdesk@mnsu.edu
http://www.microsoft.com/outlook
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In Outlook 2010, the Ribbon has replaced traditional menus and toolbars in the main Outlook window.  The 
Ribbon contains contextual commands; they generally appear only when necessary.  The Ribbon is also 
customizable. 
 

Ribbon 

  
 

N E W!  Backstage V iew 
!
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The Microsoft Office Backstage view opens, by default on the Info tab, and contains 
profile and file-level commands.  The  new  Backstage  view  replaces  the  Microsoft  
Office  button  and  the  traditional  File  menu  from  previous  versions  of  Microsoft  
Office.    The  Backstage  view  provides  a  single  location  for  all  of  your  account  
management  tasks.  Many  Outlook  settings  that  are  directly  related  to  creating  or  
managing  Outlook  items,  such  as  print  commands  and  account  management  options,  
are  now  in  the  Microsoft  Office  Backstage  view.  
  
  

 

 

 

N E W! Navigation Pane  The  order  of  the  folders  has  changed  to  make  it  easier  to  find  common  default  
folders,  specifically  the  Inbox,  Sent  Items,  and  Deleted  Items.  Some  headers  and  icons  were  removed  to  
streamline  the  appearance  of  the  Navigation  Pane  as  well.  

  

N E W!  Conversation V iew  Conversation view improves tracking and managing related messages, regardless 
of the folder that contains the messages. You can see the complete course of the conversation, including your 
responses, find the most recent responses, and more easily determine the message most important to you. You 
can also easily categorize a complete conversation. The improved conversation view can be utilized in all mail 
folders. 
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Turn on Conversation V iew 

1. On the View tab, in the Conversations group, select the Show as Conversations check box.!!

 
 
 
 
 

2. Click All folders or This folder. 

 
 
 
 
 
 
Change Conversation Settings  You can change Conversation settings from the View tab and Conversation 
Settings button. 

!

 
 
 
 
 
 
 
Ignore Conversations  If a conversation is no longer relevant to you, you can prevent additional responses 
from appearing in your Inbox.  The Ignore command moves the whole Conversation and any future messages 
that arrive in the Conversation to the Deleted Items folder.  
 
 
 
 
 
 
 
Clean Up Conversations  When a message contains all the previous messages in the Conversation, you can 
click Clean Up to eliminate the other redundant messages. For example, as people reply to a Conversation, the 
response is at the top and the previous messages in the Conversation are below. Instead of reviewing each 
message, keep only the most recent that includes the whole Conversation.  
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N E W!  Quick Steps  Turn commands and procedures that you use most often into one click. You can 
customize the default Quick Steps and create your own buttons that combine your frequent actions. The Quick 
Steps gallery on the Home tab includes buttons for one-click file and flag, sending messages to your 
department, and other popular commands.  

 

 
N E W!  Instant Search improvements  In Outlook 2010 it is easier to narrow your results by using search 
criteria such as sender, subject keywords, and other information.  The Search Tools tab includes a set of filters 
that efficiently focus your search to find the items you want. 

 

!

N E W!  Unified Messaging improvements  Voice Mail Preview provides a voice to text transcript of the 
recorded message left on your voice mail.  Within the message, click one of the words to listen to the message 
from that point on. 

 

 
Voice Mail Preview options are adjusted in MavMail 
by clicking on the Options button then the Phone tab. 

 
 
 

 
N E W!  Zoom in or out of your mail or calendar views with the new zoom slider control at the bottom right 
side of the window on the status bar. 
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V I E W T A B 
  
The  Navigation  Pane  is  the  column  on  the  left  side  of  the  Outlook  window  that  includes  sections  such  as  
Favorites,  Mailbox,  shortcuts  to  access  Outlook  areas  such  as  the  Calendar  and  Contacts.  
  
:"N)O"$)-.%!".@  

N E W!  Change the Navigation Pane font 

You can change the font and size of the text in the Navigation Pane from any 
view in Outlook. 

1. On the View tab, in the Layout group, click the Navigation Pane button 
then click Options  

 

 

 

 

 

2. Click the Font button. 

 

 

 

 

 

 

 

 
3. Enter the settings that you want in the Font, Font style, and Size boxes. 
4. Click the OK button twice to close the open dialog boxes. 

 
%
%
%
%
%
%
%
%
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O U T L O O K T O D A Y  
  
The  Outlook  Today  view  provides  a  preview  of  your  day.  By  using  Microsoft  Outlook  Today,  you  can  see  a  
summary  of  your  appointments,  a  list  of  your  tasks,  and  how  many  new  e-­mail  messages  you  have.  
  

 
 
M A K E O U T L O O K T O D A Y T H E ST A R T UP PA G E 
  
You  can  set  this  page  to  be  the  first  page  that  opens  when  you  start  Outlook  and  you  can  change  the  way  
Outlook  Today  appears.  
  
1. To  access  the  Outlook  Today  page,  click  the  top  level  folder  in  your  list  of  folders  in  the  Navigation  Pane.  
The  folder  name  is  your  e-­mail  address.    If  you  do  not  see  the  Navigation  Pane,  click  the  View  tab  then  click  
the  Navigation  Pane  button  in  the  Layout  group  and  choose  Normal.  

  
  
  
  
  
  
  
  
  
2. On  the  Outlook  Today  page,  click  Customize  Outlook  Today  (usually  in  the  upper  right  corner).  
3. �,�Q���W�K�H���6�W�D�U�W�X�S���D�U�H�D�����V�H�O�H�F�W���W�K�H���³�:�K�H�Q���V�W�D�U�W�L�Q�J�����J�R���G�L�U�H�F�W�O�\���W�R���2�X�W�O�R�R�N���7�R�G�D�\�´���F�K�H�F�N���E�R�[�������7�K�L�V���Z�L�O�O���R�S�H�Q���W�K�H��
Outlook  Today  view  whenever  Microsoft  Outlook  is  opened  next.  
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A DD L IN KS T O O U T L O O K T O D A Y T O E ASI L Y A C C ESS MSU N E WS A NN O UN C E M E N TS 
%

1. �&�O�L�F�N���W�K�H���&�K�R�R�V�H���)�R�O�G�H�U�V�«���E�X�W�W�R�Q��  
2. In  the  Select  Folder  dialog  box,  click  the  arrow  next  to  the  folders  in  the  following  sequence  to  access  the  
news  folders:  

X Public  Folders  


X All  Public  Folders  

X MSU-­Announcements  

�y  msu  
�y  announce  
  
  

  
  
  
  

3. Click  the  checkbox  next  to  the  folders  you  want  displayed  on  the  Outlook  Today  view.  
4. Click  the  OK  button  and  then  click  the  Save  Changes  button. 
5. On  the  Outlook  Today  page,  links  for  the  folders  you  have  chosen  will  appear  under  the  Messages  heading.    
Click  these  links  to  easily  access  these  folders. 
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C R E A T E A M ESSA G E 
  
1. Click  the  New  E-­mail  button  on  the  Ribbon  to  open  a  new  e-­mail  message.       

48!P    CTRL  +  N  is  the  keyboard  shortcut  to  create  a  new  message.  
  

  
  
2. Enter  recipient  names  in  the  To,  Cc,  and  Bcc  boxes.  
To  select  recipient  names  from  a  list,  click  To,  Cc,  or  Bcc.    Another  method  to  
insert  recipient  names  is  to  type  part  of  the  name  or  the  entire  name.  
  
Bcc  is  an  abbreviation  for  blind  carbon  copy.    If  you  add  a  recipient's  name  to  this  
box  in  a  message,  a  copy  of  the  message  is  sent  to  that  recipient  and  the  recipient's  
name  is  not  visible  to  other  recipients  of  the  message.    If  the  Bcc  box  isn't  visible  
when  you  create  a  new  message,  add  it  by  clicking  the  Options  tab  in  the  message  
and  click  the  Bcc  button.  
  
  
  
  
  

 

N E W! It is easier to remove a name from the Auto-Complete List.  Click the X next to the name you want to 
delete.  Also, your Auto-Complete List that stores your most recently used names is available from any 
computer where you use Outlook utilizing your Exchange account  

 

  
3. Pressing  the  Tab  key  on  the  keyboard  after  entering  a  name(s)  will  move  the  cursor  to  the  next  box  and  
verify  the  name.    Another  method  to  verify  a  name  is  to  click  the  Check  Names  button  on  the  Ribbon.    
:94' :  Alt+K  is  the  keyboard  shortcut  to  check  names.  
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N E W!  After names have been entered into a message (To, Cc, Bcc), the presence of that individual is 
displayed.  This presence is derived from the Outlook calendar. 

 
 
 

 
 
 
 
 
 
 
N E W!  Hovering the mouse pointer over a  
Information such as availability, address, phone number, and instant messaging options are easily accessible by 
clicking on the down arrow on the lower right corner of the contact card. 

 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 

 
 

N E W!  Outlook 2010 includes MailTips, which help you avoid common, but potentially costly or embarrassing 
mistakes.  MailTips alerts can be triggered by actions including sending to a large recipient list, sending 
sensitive information to someone outside your organization, or sending a message to someone who is out of 
office. 

 

 
4. In  the  Subject  box,  type  the  subject  of  the  message  and  in  the  message  body,  type  your  message.  
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M ESSA G E F O R M A TS 
  

 
 

H T M L  is the default format in Outlook. This format supports text formatting, numbering, bullets, alignment, 
horizontal lines, pictures (including backgrounds), stationery, and web pages.  Since most popular e-mail 
programs use HTML, it's the recommended format. 

Plain Text is a format that all e-mail programs understand; however, it doesn't support bold, italic, colored 
fonts, or other text formatting. It also doesn't support pictures displayed directly in the message body although 
you can include them as attachments.  

Rich Text (Outlook Rich Text Format) is a Microsoft format that only Outlook can understand. 

N E W!  Sharing what you see on your screen is easy with the new Screenshot command. In a new message, 
click the Screenshot button on the Insert tab in the Illustrations group.  Then select all or any part of your 
computer screen to include a snapshot of it in your message.   
 

 

 

 

 

 

 

 

 
 
 
 

N E W!  Resize attached photos  An option is available to resize large attached pictures.  After inserting the 
picture, click the File tab then the Info tab.  Information and options are listed about resizing the image. 
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SE T T IN G M ESSA G E I MPO R T A N C E 

On the Message tab in the Tags group, click the red exclamation point  
to set a message with high importance or click the blue arrow to set low importance. 
 
 
USIN G M ESSA G E F L A GS 
 

Flagging a message adds a flag icon to it.  You can use the flags to remind yourself to follow up on an issue or 
to indicate a request for someone else. 
 

1. Select a message then click the Follow Up button on the toolbar. 
  
  
  
  
  
  
  
  
  
  
  
 
 

2. In the Custom box, click the type of flag you want in the Flag to box. 
3. Enter the necessary dates and a Reminder if needed.   
4. Add a Flag for Recipients, if  applicable, and adjust those options. 
5. Click OK when finished. 
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5. Click  the  Send  button  to  send  the  message.     
    
  
  
If  you click the Send button on a message that does not contain a subject, a dialog box 
appears to confirm that sending the message with no subject was intentional.  

  

 

 
 
 
 
R EPL Y T O A M ESSA G E 
  
1. Select  the  message  you  want  to  reply  to.  
2. Click  the  Reply  button  on  the  toolbar.    Clicking  the  Reply  to  All  button  will  send  the  
message  to  all  of  the  original  recipients  of  the  message  except  the  Bcc  recipients.  

 
F O R W A RD M ESSA G ES 
  
1. Select  the  message  you  want  to  forward.    
2. Click  the  Forward  button  on  the  toolbar.  
 
 
C R E A T IN G A H YPE R L IN K IN A M ESSA G E 
  
1. Type  the  web  address  (hyperlink).  
2. On  the  keyboard,  press  Enter  or  the  spacebar.    This  will  create  a  hyperlink  in  your  message.    The  text  will  be  
underlined  and  a  different  font  color.  

3. To  test  the  link,  hold  the  Ctrl  button  down  on  the  keyboard  and  click  the  link.  
  

:94'P%   This  also  works  with  e-­mail  addresses  in  a  message.  
  
OPE N A H YPE R L IN K IN A M ESSA G E Y O U R E C E I V E D 
  
1. Open  the  message  that  you  received  that  contains  the  hyperlink.  
2. Click  the  hyperlink.  
3. This  will  open  a  browser  and  go  to  the  selected  address.  
 
4. Choose  the  file  you  want  to  attach  and  click  the  Insert  button.  At  Minnesota  State  University,  Mankato  the  
largest  file  attachment(s)  that  can  be  sent  through  our  e-­mail  system  is  20  MB.  

  
  
SE NDIN G F I L E A T T A C H M E N TS 
  
1. Create  a  new  message  and  enter  all  the  necessary  information.  
2. Click  the  Attach  File  button  on  the  Message  tab  in  the  Include  tab.  
3. Choose  the  file  you  want  attached,  and  double-­click  it  to  attach  it  to  the  message.  
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5. Click  the  Send  button  to  send  the  message.      
  
PRIN T A N I T E M 
  
1. Select  or  open  the  item  you  want  to  print.    
2. Click  the  Print  button  on  the  Quick  Access  toolbar                  .    This  opens  the  Backstage  View.  
3. On  the  Backstage  View,  adjust  options,  if  necessary,  then  click  the  Print  button.  
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C R E A T E A C O N T A C T 
  
The Contacts folder is your personal address book and information storage for the people and businesses you 
want to communicate with.  Use the Contacts folder to store the e-mail addresses, street addresses, phone 
numbers, and any other information that relates to the contact, such as a birthday or anniversary. 
 

 

1. In  Contacts,  click  the  New  Contact  button   on  the  left  side  of  the  Ribbon  to  create  a  new  contact.  
  

  
  
2. �7�\�S�H���W�K�H���F�R�Q�W�D�F�W�¶�V���Q�D�P�H���D�Q�G���Hnter  any  information  you  want  to  include  for  the  contact.  
3. When  finished  entering  information:  
  *    Click  the  Save  and  Close  button  to  save  and  close  the  contact.  
  *    Click  the  Save  and  New  button  to  save  the  contact  and  create  a  new  contact  or  a  new  contact  from  the  
          same  company.     
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C R E A T E A C O N T A C T G R O UP (F O R M E R L Y DIST RIBU T I O N L ISTS) 
  
A  contact  group  is  a  collection  of  contacts.    It  provides  an  easy  way  to  send  messages  to  a  group  of  people.    You  
can  use  contact  groups  in  messages,  meeting  requests,  and  task  requests.    Contact  groups  are  stored,  by  default,  
in  your  Contacts  folder.    The  contact  groups  you  create  in  your  Contacts  folder  are  available  only  to  you;;  
however  you  can  send  them  to  others.  
  
1. In  Contacts,  click  the  New  Contact  Group  button  on  the  Ribbon.  
  
2. In  the  new  contact  group,  type  a  name  for  the  group  in  the  Name  box.    
  

  
  
3. Click  the  Add  Members  button  to  choose  a  list  to  select  members/recipients  for  the  contact  group.    Click  
From  Address  Book  to  choose  from  the  Global  Address  List  (campus)  or  click  From  Outlook  Contacts  to  
choose  from  your  personal  contact  list.  

  

  
%
%
4. Add  members  to  the  group  by  double-­clicking  on  them  from  the  list  and  this  will  add  them  to  the  Members  
list  at  the  bottom  of  the  dialog  box.    Click  the  OK  button  at  the  bottom  of  the  dialog  box  to  close  the  list.  

5. Click  the  Save  &  Close  button  on  the  Ribbon  to  finish  creating  the  contact  group.  
% %

mk:@MSITStore:C:/Program%20Files/Microsoft%20Office/Office10/1033/olmain10.chm::/html/olconAboutDistributionLists.htm%23%23


Page  17  of  20  

<0).O%".C%'LM".C).O%,-.$"/$%=#-EM0%
  
1. In  a  message,  enter  the  group  name  in  the  To:,  Cc:,  or  Bcc:  line.  
  
  
2. After  the  name  is  verified,  a  plus  sign  will  appear  to  the  left  of  the  name.    
3. Click  on  the  plus  sign  to  expand  the  group  and  view  the  members  of  the  group.  You  cannot  undo  this  action.  
4. If  you  receive  the  following  dialog  box,  click  the  OK  button  to  expand  the  list.  
  

  
C R E A T E A F O L D E R 
  
Folders  are  created  to  store,  archive,  and  organize  items  and  information  in  Microsoft  Outlook.    Within  these  
folders  you  can  store  e-­mail  messages,  tasks,  appointments,  contacts,  and  notes.  
  
1. On  the  Folder  tab,  click  the  New  Folder  button.  
  

  
  

2. In  the  Name  box,  enter  a  name  for  the  folder.  
3. In  the  Folder  contains  list,  click  the  type  of  items  you  want  the  folder  to  contain.  
4. In  the  Select  where  to  place  the  folder  list,  click  the  location  for  the  new  folder.  
5. Click  the  OK  button  to  finish  creating  the  folder.  
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M O V E A M ESSA G E IN T O A F O L D E R 
%
1. Select  the  message  to  be  moved.  
2. On  the  Home  tab  in  the  Move  group,  click  the  Move  button.  
3. �&�O�L�F�N���2�W�K�H�U���)�R�O�G�H�U�«  

  
  
4. In  the  Move  Items  dialog  box,  choose  a  folder  and  click  the  OK  button.    The  message  will  be  removed  from  
the  existing  folder  and  placed  in  the  selected  folder.  

  

  
  

 
D E L E T E M ESSA G ES 
  
1. Select  the  item(s)  you  want  to  delete.    
2. Press  the  Delete  button  on  the  keyboard  or  click  the  Delete  button  on  the  Ribbon  on  the  Home  tab.  
  
  
  
  
  
  
  
  
When  you  delete  a  message,  the  message  is  moved  to  the  Deleted  Items  folder.    Make  sure  you  periodically  
empty  the  Deleted  Items  folder  because  these  messages  still  occupy  space  in  your  mail  quota.  
%
48!P  By  pressing  Shift+Delete  on  the  keyboard,  will  M@#(".@.$*A  the  selected  item  rather  than  move  it  to  the  
Deleted  Items  folder.    Also,  remember  to  empty  your  Junk  E-­mail  folder.    
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C R E A T E A SI G N A T UR E 
  
You  can  use  a  signature  to  insert  information  to  the  messages  you  send.    You  can  create  multiple  signatures  and  
select  a  signature  to  insert  in  a  message.  
  
: '1Q %%6-"().O%0)O."$E#@0%�±  Custom  signatures  you  create  for  your  messages  are  available  to  you  from  any  
computer  you  use.  
  
1. Click  the  File  tab,  click  Options  then  click  the  Mail  tab.  
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2. Click  the  Signatures�«   button.  
  

  
  

4. On  the  E-­mail  Signature  tab,  click  the  New  button  to  begin  creating  a  signature.  
5. Type  a  name  for  the  signature  and  click  the  OK  button.  
  

  
  

6. Begin  entering  your  information  in  the  Edit  signature  box.    Adjust  the  font,  font  size,  font  attributes,  etc.  as  
you  like.  

  

  
  

7. Click  the  Save  button  when  finished.    The  newly  created  signature  is  displayed  in  the  list.      
8. Under  Choose  default  signature,  choose  a  signature  for  New  messages  and  Replies/forwards.  
9. Click  OK  to  complete  the  steps.  
10. Click  OK  to  close  the  Outlook  Options  dialog  box.  


